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m QMR of the Month

We are pleased to announce this month’s Winner of QMR of the Month:

Brandon Moller from
Bill Kolb Jr. Subaru in Orangeburg, NY

The winning QMR Brandon submitted described a 2018 Impreza
with an unusual customer concern of the windshield wipers coming
on intermittently without any switch input from the driver. At first,
he was unable to confirm the condition but, after repeated attempts
and opening / closing the driver’s door to add some extra vibration,
the wipers came on erratically at 1-3 second intervals and with the
switch in the OFF position. After connecting the SSM to confirm
proper wiper switch input to the BIU, he verified the ON signal but,
it would intermittently switch to OFF for a split second which he
documented in his report by supplying a video attachment. Wiring
checks between the harness connectors at the switch and the BIU
were all normal with no shorts to power, ground or any abnormal
resistance found. Brandon suspected the wiper switch as the root
cause but before replacing it, he performed comparison resistance
and continuity checks between a new and the suspect part to
successfully confirm his suspicion. Normal wiper operation was
restored by replacing the faulty switch. Brandon’s report included
an additional video of the wipers operating erratically along with
detailed results and photos of the testing he performed prior to
replacing the switch.

In appreciation for going the extra mile and sharing his experience
with us, Brandon will be receiving the following from his Field Service
Engineer.

A $500.00 Snap-On gift card.

Continued on the next page

CAUTION: VEHICLE SERVICING PERFORMED BY UNTRAINED PERSONS
COULD RESULT IN SERIOUS INJURY TO THOSE PERSONS OR TO OTHERS.

The Subaru TechTIPS newsletter is intended for use by professional Technicians ONLY. Articles are
written to inform those Technicians of conditions that may occur in some vehicles, or to provide
information that could assist in the proper servicing of the vehicle. Properly trained Technicians
have the equipment, tools, safety instructions, and know-how to do the job correctly and safely.
If a condition is described, DO NOT assume that your vehicle has or will have that condition.
Impreza, Legacy, Justy, Loyale, Outback, Forester, Subaru SVX, WRX, WRX STI, Baja, Tribeca,
BRZ, XV Crosstrek, Ascent, Crosstrek Hybrid and “Quality Driven” are Registered Trademarks.

SUBARU OF AMERICA, INC. IS
ISO 14001 COMPLIANT

IS0 14001 is the international standard for ex-
cellence in Environmental Management Sys-
tems. Please recycle or dispose of automotive
products in a manner that is friendly to our
environment and in accordance with all local,
state and federal laws and regulations.
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m QMR of the Month (continued)

The other Regional winners selected from QMRs submitted during December 2019 were:
* Garrett Fuchs from Baierl Subaru in Pittsburgh, PA
e Zachary Sklarew from Michael’s Subaru of Bellevue in Bellevue, WA
* Dan Sexauer from Lou Fusz Subaru - St. Peters in St. Peters, MO
e Nathan Williams from Atlantic Subaru in Bourne, MA

Any Subaru Technician can participate in the QMR of the Month program. See the February 2013 and
January 2016 issues of Tech TIPS for full details. You just might see your name and photo in a future
issue of Tech TIPS!

m QMR of the Month Award Presentation

As part of our “enhanced” QMR of the Month recognition program, we will include a photo (whenever
available) of the recipient’s award presentation in TIPS. The winner selected from QMR of the Month
submissions received during December 2019 was Brandon Moller, a Technician from Bill Kolb Jr. Subaru
in Orangeburg, NY.

Brandon is shown above (center) after being presented with his $500.00 Snap-On Gift Card by Subaru
Distributors Corporation Field Service Engineer Jim Colamarino to his left. Pictured here (left to right)
are: Bill Kolb Jr. Subaru’s Fixed Operations Director, Joe Minns, Assistant Fixed Operations Director
Jessica Rolon, December’s winning Technician Brandon Moller, Jim Colamarino and Shop Foreman,
John Cote. Congratulations and THANK YOU to our December 2019 QMR of the Month Award recipient!

Continued on the next page
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TECH TIPS GREATEST TIPS

This series features TechTIPS articles frequently referred to by Techline. This month’s feature is from
November 2018.

m NEW MODEL ALIGNMENT SPECIFICATIONS

As new models are released, Technicians often find their alignment machines do not have the
alignment most up-to-date specifications stored. To ensure a vehicle handles properly and to provide
the highest quality repair for our customers, it is imperative to properly adjust alignment angles to
specification. Alignment specifications are found in every Service Manual by clicking Suspension
> Front Suspension > Wheel Alignment > Inspection. Once you have the specifications, you
can enter them into your alignment equipment. If you are unsure how to manually enter alignment
specifications, please contact your equipment supplier.

REMINDER: Always ensure your alignment software is up to date. Never use incorrect specifications.

m 2019MY and up Forester MFD Displays Incorrect Vehicle Angle

Technicians have been encountering a customer 76 semema '’ 76 & 55 F
concern of the MFD is always displaying the e

vehicle pitch and/or yaw at a value other than 0
degrees even when parked on a seemingly level
surface. Diagnosis for this concern should start
with examining the Auto Headlight Beam Leveler

Control Module. 76 - AUTO "’-
[ [ [ [Ssiesiasias) —

The MFD receives this information from the Auto
Headlight Beam Leveler Control Module. The
Headlight control module installation is key for
proper operation. The module is located above
the steering column in the driver’s front footwell
area. Check the mounting bolt and bracket to
ensure both are secure, and the bracket has not
been moved, bent or otherwise damaged.

After determining the mount is properly installed,
make sure to complete the reinitialization
procedure. This can be found in Body &
Electrical/Wiring > Lighting System >
Auto Headlight Beam Leveler System >
Procedure.

CONTROL MODULE

Continued on the next page
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m Ascent Sunroof and Sunshade Motors

When replacing a sunroof frame, or during any sunroof diagnosis, it is imperative to ensure the sunroof
and sunshade motors are installed correctly. The motor for the shade and the glass look interchangeable
but, this is not the case as there are distinct internal differences. Also, the connectors for the motors
are the same shape which allows them to be easily installed incorrectly. Refer to the Service Manual to
ensure the correct motor is installed to each location and the correct connector is plugged in to each
motor.

Go to Body & Electrical/WIRING SYSTEM

> SUNROOF/T-TOP/ CONVERTIBLE TOP
(SUNROOF) > Sunroof Motor > REMOVAL for
motor identification.

SR-10079

(a) Motor ASSY shade
(b) Motor ASSY lid

. 1
oot o - :>>
5 R R .
AD41 and AD42 are the connectors for the o o aa—
sunshade and sunroof motors. Notice the wire m—— _T_B|Z>>
Be

colors and pin positions are identical, except 8 Be
pin number eight. AD41 pin eight has a green
wire whereas AD42 pin eight has a blue wire.
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m Power Rear Gate (PRG) Inoperative with Ignition ON and / or Engine Running

If a vehicle presents with a customer concern of the PRG only working when the ignition is OFF, check
the PID for the Park switch. If the PID shows the Park signal is OFF, the PRG will not operate. This
keeps the PRG from operating when the vehicle is in motion. The Park signal must be ON for the PRG to
operate. The problem was found to be contamination in the Park-Range switch located in the selector
lever assembly. See TSB 16-112-18R and the June 2017 issue of TIPS for more related information.

m Rattle Sound from Steering Wheel Area

Late model Subaru vehicles have many different components installed to the steering wheel. Each
component has its respective wiring harness. When diagnosing a customer’s concern of a rattle noise
coming from the steering wheel area it is important to confirm the wiring harnesses are routed correctly.
Use this check point guide to confirm all wiring harnesses are routed appropriately.

Check point@

The paddle shift
harness is touching
steering wheel cover
or not.

Check point®
The harness is stuck
between steering

wheel and satellite
switch cover or not.

Check point®
fll The clips are grabbing
j satellite switch
harness correctly or
not.

Check point@®
The horn pad harness is
wiring Right-side of

satellite switch harness
or not.

Continued on the next page
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m Rattle Sound from Steering Wheel Area (Continued)

CHECK POINT (1)

¢ The satellite switch harness (brown) is secured by two clips. Make sure the harness is fully installed
into each clip as shown below.

Satellite switch harness |

CHECK POINT (2)
¢ Make sure the paddle shift harness is touching with steering cover or not.

¢ The paddle shift harness should be routed below the satellite switch harness. If the paddle shift
harness is touching the steering column cover re-route the paddle shift harness below the satellite
switch harness.

¢ |f the paddle shift harness is still touching the steering column cover after correcting the harness
routing, please install non-woven tape or EPT foam tape on the paddle shift harness to prevent a
possible rattle sound.

| . Steering cover
Incorrect wiring

-

Paddle shift a e
; oy

harness

Continued on the next page
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m Rattle Sound from Steering Wheel Area (Continued)

CHECK POINT (3)
¢ Check to see if the satellite switch harness is stuck between the steering wheel and the satellite

switch cover.
¢ If the satellite switch harness is stuck there, push the satellite switch harness back into the satellite

switch cover. Always be sure to check BOTH satellite switches.

Left side satellite switch Incorrect wiring

Satellite switch cover

Correct wiring

Steering wheel

Satellite switch harness

CHECK POINT (4)
¢ Confirm horn pad harness wiring runs to the right side of the satellite switch harness or not.
¢ If the horn pad harness is wiring is on the LEFT side of the satellite switch harness, move it to the
right side of the satellite switch harness.

Satellite switch
harness

s

. ——
Horn pad harness = .

Continued on the next page
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m Errors when Programming with Flashwrite®2

Several retailers have reported issues with FlashWrite®2 while reprogramming vehicles. Please review
the following TIPS to prevent and/or correct some of these issues.

VERIFY YOUR SUBARU SELECT MONITOR SOFTWARE VERSION

First, open the Subaru Select Monitor 4 program, select the bottom left gear icon> Help> Version
Information.

I
File »
Print
Function ¥
Setup »
Display Menu Area *
Play Project
Help » Activation

H O Type here to search Help E

The SSM4 version number is listed as “Ver.xx.x.x” and is displayed in the red box in the photo below.

SUBARU Select Monitor 4

@ SUBARU Select Monitor lVer.20.1.1

Updatable until 2020 - 10

2020, 1
Available until 2021 month 9

Copyright (C) 2015 SUBARU CORPORATION

7 =

If your version is before 20.1.1 it needs to be updated (as of February 2020.) Please contact Nuspire at:
(844) 782-7404 for update assistance.

“NOT SUITABLE FOR REPROGRAMMING” MESSAGE

Ifyou encounter a ‘Not Suitable for Reprogramming’
message during a reprogramming session, verify
there are no DTCs stored. The Techline has received
numerous calls with this concern. After verifying
the correct PAK file had been selected and getting
the ‘Not Suitable’ message, a P-code was found
stored in ECM memory. After addressing the DTC
and clearing the memory, the update completed
normally.

Pass-Thrt 'Piepmgramiﬁg

Continued on the next page
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m Errors when Programming with Flashwrite®2 (Continued)

“ERROR OCURRED IN THE DECRYPTION. CHECK THE DECRYPTION KEYWORD” MESSAGE

FlashWrite X
I
7 [108]
Error occurred in the decryption. Check the decryption
keyword,
OK

T bl R R ek

Error code 108 occurs when the Decryption Keyword is not entered correctly or when the incorrect PAK
file is selected. If you get Error 108, first ensure you are entering the decryption keyword as it is written
as they are, case sensitive. If you are sure you have entered the correct Decryption Keyword, ensure
you are using the correct PAK file. Sometimes, a database error may occur and provide the incorrect
PAK file. To make sure this is not the case, try searching by the Vehicle Specification if you initially
searched by CID, or search by CID if you initially searched by Vehicle Specification. If you find the PAK
number differs based on the type of search, submit a QMR with screenshots or photos of the condition.

CONTROL MODULE RECOVERY PROCEDURE

NOTE: The same laptop must be used to recover the control module that was in use when
reprogramming had failed.

There are several reasons why reprogramming may fail: low vehicle battery, loss of electrical power
to the laptop or vehicle, dislodged OBD2 or USB cables, etc. In most cases it is NOT necessary to
replace the Engine Control Module (ECM.) The following procedure should be used to recover an ECM
which has failed to program. Prior to performing this procedure, ensure your laptop, DST-I, and all
cables are in proper working order. If you have issues with the hardware, contact Nusplre support at

(877) 782-7404 for assistance with any needed repairs. p,s,.nw Wmﬂg '
Recovery procedure
1. Turn the ignition switch to the “OFF” position for at No response fiom the E 1)
least 15 seconds. || Part Number

309194F338

2. Turn the ignition switch back to the “ON” position and
restart FlashWrite®2.

3. Proceed with the appropriate file selection for the
vehicle specification.

4. Once FlashWrite®2 begins to communicate with the
vehicle, the following message will be displayed with
the appropriate control module part number displayed:

Click on the part number to highlight it. THIS IS VERY
IMPORTANT.

Continued on the next page
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m Errors when Programming with Flashwrite®2 (Continued)

5. Select “Yes” and FlashWrite®2 will show the current and new control module part number screen.

| dearcnrigain—

Iption

Search Condition Search Result
D

Tran.. CPU

Engine Aspiration

EmissionSpec

packNumber Year  VehicleLine non-Turbo

/IVehicle Spec >
Pass-Thru Reprogramming

ROMID :
This ECU(Electronic Control Unit) is suitable for reprogramming,

NT
765AJ621 -

cp# Current Part Number 22765A.J620.22765 ¥ - M |
i T,

: This ECU(Electronic Control Unit) will be reprogrammed into the following part numbe: o g ‘
New Part Number 22765A625 ‘

Continue

panied by
5 stopping

Necessary connector : None

Decryption Keyword : 98238F2B

6. Select “Execute” and FlashWrite®2 will begin the reprogramming process.

7. If you incorrectly answer the “Is reprogramming in process?” question “NO”, you will receive error
code 4007 “No response from the ECU. Check the cause of no response.”

8. If this is the case, turn the ignition switch off for at least 15 seconds and begin the recovery
process again.

NEXT STEPS

After verifying the previous procedures and confirming they do not correct the reprogramming
issues, contact Nuspire support at (844) 782-7404. They will verify if your Subaru laptop system

is up to date and functioning properly. If not, they will refer you to the Subaru Technical Helpline
(866) SUBARU-2.

HELP FOR OTHER ERROR CODES

FlashWrite®2 is capable of setting many different error codes. Their definitions and check items are not
published to STIS. To find the definitions and check items select the bottom left gear icon> Help>
Help

File »
Print
E Function ¥

Setup b

;ﬁc Display Menu Area ¥
i3

Play Project
5

| Help » Activation

Yersion information

O Tyve here to search I

This will open the SSM4 user guide. Error code definitions and check items are listed under “Control
Module Reprogramming Error Code List.”

Continued on the next page
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m STIS new releases

CREATED
ITEM CODE ITEMTYPE TITLE DATE

07-170-20 Technical Service Bulletin Reprogramming File Availabilit... 21-Feb-20
03-83-20R Technical Service Bulletin New Shift Fork and Sleeve Avai... 21-Feb-20
07-169-20 Technical Service Bulletin Push Button Start Switch- Labe... 21-Feb-20
01-180-20 Technical Service Bulletin Incorrect Freeze-Frame Data De... 21-Feb-20
07-162-19R Technical Service Bulletin Automatic Door Lock / Unlock F... 21-Feb-20
15-130-08R Technical Service Bulletin Load Carrying Capacity Reduced... 21-Feb-20
15-260-20 Technical Service Bulletin Harman Display Audio and Navig... 21-Feb-20
07-158-19R Technical Service Bulletin DTC B280B- EyeSight Camera Rep... 21-Feb-20
15-205-16R Technical Service Bulletin Reprogramming File Availabilit... 19-Feb-20
15-259-20 Technical Service Bulletin Denso Gen 4 Cockpit One (CP1) ... 19-Feb-20
15-236-18R Technical Service Bulletin Reprogramming File Availabilit... 19-Feb-20
15-186-15R Technical Service Bulletin Reprogramming File Availabilit... 19-Feb-20
15-199-16R Technical Service Bulletin Reprogramming File Availabili... 19-Feb-20
15-211-17R Technical Service Bulletin Reprogramming File Availabilit... 19-Feb-20
12-281-20 Technical Service Bulletin Hood Panel Vibration 19-Feb-20
MSA5M2001W | Warranty Booklet 2020 Warranty and Maintenance ...
SOA567P011 Accessory Installation Guide Thule SUP Taxi XT 810001 13-Feb-20
11-200-20 Technical Service Bulletin Reprogramming File Availabilit... 13-Feb-20
15-234-18R Technical Service Bulletin 2019 Audio/Navigation & Power ... 12-Feb-20
15-214-17R Technical Service Bulletin 2018 Audio/Navigation Exchange... 12-Feb-20
WUJ-95R Subaru Product/Campaign Bulletin | Exhaust Pipe Front (EPF) Bello... 12-Feb-20
15-204-16R Technical Service Bulletin 2017 Audio/Navigation Exchange... 12-Feb-20
11-199-20 Technical Service Bulletin Reprogramming File Availabilit... 11-Feb-20
11-198-20 Technical Service Bulletin DTCs P219C, D, E or F- ECM Rep... 11-Feb-20
11-197-20 Technical Service Bulletin DTC P0400-Reprogramming File A... 11-Feb-20
07-142-18R Technical Service Bulletin Battery Sensor Removal and Ins... 10-Feb-20
J201SFL002 Accessory Installation Guide PORT INSTALLATION: 2020MY Asce... 10-Feb-20
J201SAN00O Accessory Installation Guide PORT INSTALLATION: 2020MY Lega... 10-Feb-20
J201SFLO00 Accessory Installation Guide PORT INSTALLATION: 2020 Imprez... 10-Feb-20
H630SFL002 Accessory Installation Guide PORT INSTALLATION: 2018-2020MY... 10-Feb-20
WUT-05R Subaru Product/Campaign Bulletin | Forester Rear Coil Springs 7-Feb-20
WUR-03R Subaru Product/Campaign Bulletin ' Brake Hose Swelling Service Pr... 5-Feb-20
L101SSJ000 Accessory Installation Guide PORT INSTALLATION: 2019-20MY F... 5-Feb-20
TKC-20R Subaru Product/Campaign Bulletin | Takata Front Passenger Airbag ... 4-Feb-20
TKB-20R Subaru Product/Campaign Bulletin | Takata Front Passenger Airbag ... 4-Feb-20
TKA-20R Subaru Product/Campaign Bulletin | Takata Front Passenger Airbag ... 4-Feb-20

All revised publications are highlighted in yellow.
February 2020 TechTIPS
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m STIS new releases

CREATED
ITEM CODE ITEMTYPE TITLE DATE

WUW-08R Subaru Product/Campaign Bulletin | PCV Valve- Design Change 4-Feb-20
oS AMA-SE- ochTIPS NewsLetter 2020 January TechTIPS OMR Spec... | 3-Feb-20
L101SANOOO Accessory Installation Guide 2020 Qutback Trailer Hitch (En... 1-Feb-20
06-74-20 Technical Service Bulletin Electronic Parking Brake (EPB)... 31-Jan-20
WUX-09R Subaru Product/Campaign Bulletin 1 2016-2017 Outback Replacement ... 31-Jan-20
12-280-20 Technical Service Bulletin A-Pillar Trim- Gap Visible at ... 31-Jan-20
07-152-19R Technical Service Bulletin Power Window Switch Changes 31-Jan-20
11-196-20 Technical Service Bulletin PCV Valve Part Information 31-Jan-20

Continued on the next page
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*** Now you can e-mail your TechTIPS input and suggestions to: tech@subaru.com ***

This is your chance to offer suggestions for use in future issues of TechTIPS! Make sure
that if you e-mail us, you place in the subject line of your e-mail “For TechTIPS Newslet-
ter”. Thank you!

Model:

Year:

VIN:

Description of situation encountered:

Your suggestion for repair procedure, product improvements, etc.:

Please attach separate sheets, if necessary. You may also want to include Service Manual dia-
grams or references, or your own drawings to assist in describing your suggestion. All information
submitted becomes the property of Subaru of America, Inc. Permission is granted to Subaru of
America, Inc. to print your name and suggestions in TechTIPS and other Subaru of America, Inc.
publications. Mail items to: PO Box 9103; Camden, NJ 08101-9877.

Your Name:

Signature:

Dealer’s Name:

City:

Date:

Dealer Code:

SUBARU TECHLINE Monday — Thursday 8:30 am to 7:30 pm

Hours of Operation Friday 10:30 am to 5 pm and Saturday 9 am to 3 pm
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